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Welcome to the latest edition of my Final Cut Pro newsletter!

The goal of this newsletter is to provide information helpful to the
professional user of Final Cut Pro. This newsletter publishes
around the middle of each month. Past issues are not archived,
however, key articles are posted to my website for your future
reference. All software references are to Final Cut Pro 5 unless
otherwise noted.

Please invite your friends to visit my web site -- www.larryjordan.
biz. We are working to make it a great Final Cut resource!
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Welcome

It's been a busy summer -- our company has been growing and we are
developing some exciting new products for release later this year. You'll
learn about the first in about three paragraphs.

As well, this newsletter now focuses principally on Final Cut Pro 5 --
though all you FCP HD users are not forgotten, as you'll see when you
read the Technigue on using Auto-Render. There are many similar
features between the two applications, so I'll let you know if a particular
technique works in both versions.



http://www.larryjordan.biz/
http://www.larryjordan.biz/

For those still waiting to upgrade, | have further thoughts on that later in
this issue, as well.

Still, for me, the exciting part about publishing this newsletter is reading
your comments and questions. Feel free to write and share your
thoughts, tips and success stories. | learn something new every time
someone writes and | enjoy sharing your ideas with the world.

New: Larry's Final Cut 5 Book Coming September 7!

Well, it's taken all summer, but I'm pleased to announce my newest
book -- Hands-on Training for Final Cut Pro 5. Published jointly by
Peachpit Press and Lynda.com, this is a significant revision to my best-
selling FCP HD book.

The book will be available world-wide starting Sept. 7 and next month's
newsletter will have more information about it -- including the ability to
order it directly from my website. For now, I'm glad the months of work
are just about over. I'm looking forward to seeing it in print and getting
your reactions.

New: Final Cut Pro Seminar -- Chicago, October 29

Grab your calendars. Our next Final Cut Pro seminar is now official --
October 29 -- at the Courtyard Marriott in EImhurst, lllinois. I'm calling it
"Supercharge Final Cut Pro 5," but as I'm writing the seminar now,
things will change. Let me know if there's something special you'd like to
learn.

We are working on other cities and dates and will have more to
announce next month.

Call (818) 879-5105 to make a reservation.

Registration is $225, and includes my latest FCP 5 book and lunch.
Student pricing is available -- call for more information.

[Go to top.]

Technique: FCP 5 - Setting up a Multiclip

Multiclips are new with FCP 5 and provide the ability to see multiple
camera angles at the same time. However, while they are easy to use,
they can be tricky to set up. So, this technique explains the steps you
need to follow to get everything working smoothly.

In this example, | have a ice-skating performance from four cameras
that I want to cut into a single segment. The audio was recorded directly
from the audio board onto one of the cameras. These clips are from my




up-coming book (Hands-on Training for Final Cut Pro 5) and are courtesy
of Greene HD Productions (http://www.greenehdtv.com).

1. Import your clips. Either capture or import the clips you want to
include in your Multiclip.

Open in New Viewer
Open in Editor
Rewveal in Finder

Batch Captwre...

Reconnect Media...

Media Manager...

Make Offline...

Duplicate as Mew Master Clip
Mearge Clips...

Make Multiclip... [
Make Multiclip Sequs¥

Export | 4

2. Create a multiclip. Select the clips you want to group together. Then,
control+click on one of them and select Make Multiclip. You can group
up to 128 clips in a multiclip, and you can view up to 16 at once.
However, the more clips you view, the faster your hard disk needs to be.
If you want to play more than four or five clips, you'll need a RAID.
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Make Multiclip

In Points
Out Points

Synchronize using:

Media Sync

Alignment Time
il [1] - RW - cam 1 | ' 00:00:00:00
v [2] - RW - cam 2 | 00:00:00;00
il [3] - RW - cam 3 | 00:00-00:00
v [4] - RW - cam 4 | | 00:00:00;00
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3. Select how you want to sync the clips: In, Out, or Timecode. If you
are using an In or Out, you'll need to set the In or Out prior to creating
the multiclip. A clapper slate, or camera flash or someone's hands
clapping all make good places to set an In, provided all cameras can
clearly see it at the same time.
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4. Drag the multiclip from the Browser into the Viewer.



2 from Seq - Multiclip Start

Saq

+ Show Overlays

Show Excess Luma

Show Multiclip Overlays
Show Source Angle Effects

+ Black
White
Checkerboard 1
Checkerhnard 2

Multiclip 1-Up

@@ 7/ Multiclip 4-Up | A\l

Multiclip 9-Up
Multiclip 16-Up
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You can select how many angles you want to see at one time by
choosing from the top right pop-up menu. In this case, we want to look
at four angles at once. The maximum is 16.
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5. Set the In and Out of the multiclip. Care to guess how to set the In
and Out? Right. The exact same way you'd set an In or Out on a normal
clip. You don't have to set an In or Out; but it's nice to know you can. In
this case, we will.

B Overwrite - F10

6. Edit the clip to the Timeline. If you try to drag the clip to the Timeline,
or Canvas, it won't drag. Instead, I've found it easiest to click the red
envelope in the lower-left corner of the Canvas to edit the clip to the
Timeline at the position of the playhead.



You can also Option-double-click to load the multicilp to the Timeline.

alala Viewer: RW - cam 1 from Seq - Multiclip Start
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7. Sync the Timeline to the Viewer. The easiest way I've found to do this
is to double-click the multiclip from the Timeline to load it into the
Viewer. Then, select Sync > Open from the center pop-up menu in the
Viewer.

BA8 Viewer: RW - cam 2 from Seq - Multiclip Start

£ [ 00:01:46:02 (49%T) @  syncos
¥ Open
- Gang

Video + Audio
Video

WILL: RW - cam 1
A[L]: B\ - cam 1

8. Set your starting track for audio in the Viewer. Go to the Sync pop-up
menu and select Sync > Audio > All. Then, click the camera angle you
wish to use for audio. Generally, I've found that | either want to switch
audio and video together (which we are not doing in this example) or |
want to lay down a single audio track and cut video against it. This is
what we are doing here.

1(ala2) | Filters | Motion
02| gEnET) @l  sync o
Open
Gang

Video + Audio
Audic % P

WILL: RW - cam 1
A[1]: BW - cam 1

V121 RW - cam 2
Al2]: W - cam 2

W3] RW - cam 3

9. Set your starting angle for video in the Viewer. Now that we have the
audio selected, we need to set our opening angle. Apple calls changing
the opening angle, "switching,” and it calls changing the angle during
playback, "cutting." | disagree with the terms, but | can learn to live
with it over time. In this case, go back to the center pop-up menu and
select Sync = Video. Then, click on the shot you want to use to start
the clip.
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Notice the green and blue rectangles around the image? The green
rectangle indicates which camera your audio is coming from. The blue
rectangle indicates the current video angle.

10. Select the Timeline and move the playhead to the beginning of the
clip. Here's where | often have problems. Double-click the clip to make
sure it's still loaded into the Viewer, then make sure the Sync pop-up is
set to Open.
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11. Play the clip and click in the Viewer on the shots you want to edit to
the Timeline. (You can also use the keys on the keypad or click mouse
buttons. I've found clicking the the Viewer to be the fastest and best.)
As you select different camera angles, they are automatically edited to
the Timeline.



Tom Wolsky sent in the following additional information:

Another way to set the audio, which | almost prefer as | don't
have to think about it, is to edit the audio only into the
Timeline from the correct camera, and then edit the video
only from the muilticlip.

Clicking the clips to cut only seems to work during playback (i
think was was changed in 5.0.2 as my recollection is it didn't
work in earlier versions). If you aren't playing the director
but choosing your edit spots and then cutting you have to
use either the buttons or the keyboard shortcuts.

R
¥ Unlimited KT

Play Base Layer Only

¥ Scrub High Quality

Playback Video Quality
¥ Dynamic
High
Meadium
Low

Playback Frame Rate
¥ Dynamic

Full

Half

12. If you are unable to play the multiclip without dropping frames, go
to the RT pop-up menu in the upper-left corner of the Timeline and set it
to Unlimited RT, with BOTH Dynamic Frame Rate and Dynamic
Video Quality checked. Multiclips are very taxing on slower systems.
The new version of Unlimited RT, called Dynamic RT, makes it possible
to play very complex effects on slower computers in real-time.

13. Stop at any time and trim individual clips on the Timeline as
necessary. All the standard trimming tools, such as Roll or the Selection
Arrow, work on multiclip edit points.

14. When you are completely finished editing the multiclip, choose
Modify > Collapse Multiclip(s). This disconnects the clips in the
Timeline, so that only one clip plays at a time. This significantly reduces
the work your hard disk needs to do and speeds overall system
performance. You can recreate your multiclip at any time by selecting
the clips and choosing Modify = Uncollapse Multiclip(s).

And that's it. I've found cutting multiclips to be great fun -- especially
when | remember what it was like directing multiple cameras from a
remote truck.

[Go to top.]




Technique: FCP 5 -- New Render Settings

New with this FCP 5 are improved render settings for scaling and
rotation. You can see these in two places: when you first open a project
from an earlier version of FCP into FCP 5, or by going to Sequence >
Settings > Video processing tab.

This technique explains what these new settings do and how to use them.

When you open an project from an earlier version of Final Cut, you are
first asked if you want to update it. If you select No, FCP cancels
opening the project. If you select Yes, FCP opens the project. Now, at
this point, your project is still stored in the old format on your hard
drive. The updating isn't permanent until you save the project file.

F ¥ v =
il 2 L

Best

MNormal -'_'. '
Fastest {linear) .

The next dialog that appears asks how you want to set your render files.
The default setting is normal. In Final Cut HD, we didn't have a choice in
rendering. Now, we do.

What Apple did was significantly improve the algorithms Final Cut uses
to calculate scaling (size changes) and rotation. If you don't change the
size or rotation of your clips in the Timeline, then none of this discussion
matters. You can skip to the next section. For the rest of us, read on.

Render settings are applied to each sequence. So, different sequences in
the same project can have different render settings.

There are three selections: Faster, Normal and Best.

Faster: This is the render setting for FCP HD. It looks OK, but, frankly,
it shouldn't be your first choice, unless you are planning to use the
current project to replace a portion of the video in an earlier project. In
which case, using the same rendering settings will help assure that the
video matches.




Normal: This is the default setting for FCP 5 and even on my computer
screen | can see an improvement. This is even more noticeable on a
video monitor. However, it takes longer to calculate an effect at this
level of quality.

Best: This is the best setting to use if you are doing a lot of
compositing, however, it takes the most time. According to my highly
unscientific testing, if Faster renders in 10 seconds, Normal will render in
30 and Best in 40.

r

Best
Normal

If you have a project that has already been converted to FCP 5, or if you
want to change the render settings to an existing project, open the
sequence you want to change and choose Sequence > Settings > Video
Processing tab.

Best

Fastest (linear) E

Just as when you open an older project, you can select between the
three different render choices.

Which one should you use? Well, I'll tell you what | do. 1 use Normal for
all my editing, then, just before outputting to tape, | change the render
settings on my final sequence to Best and re-render. This gives me the
highest quality with the least amount of time spent waiting for FCP to
render.

(Remember, also, that even though the Timeline shows green render
bars, meaning that FCP can play your Timeline in real-time, all effects
must render before output to tape. So, since FCP will spend time
rendering before final tape output anyway, | figure that | should take
advantage of all this and have it render at the best quality.)




Tom Wolsky sends the following note:

The whole Fastest, Normal, Best seems to be raising
problems in some areas. Despite the improvement in scaling
many people are reverting to fastest when having to render
titles as normal and especially best appear to significantly
degrade the text. Switching to fastest seems to alleviate this
problem.

[Go to top.]

Upgrade Recommendations to Final Cut Pro 5

I've been getting a lot of questions over the last month regarding
upgrading to Final Cut Pro 5. Based on my own experience, and lots of
conversations with other experts, here are my current recommendations:

. Final Cut Pro 5 seems as stable and effective as Final
Cut HD when run on OS X 10.3.9. Be sure to upgrade
to FCP 5.0.2 as soon as possible.

. Tiger (OS X 10.4.2) does not seem as stable as OS
10.3.9 and should be avoided for professional
applications, where possible.

. Running Final Cut Pro HD on 10.3.9 is fine, provided
you do not upgrade to QuickTime 7.

. Final Cut Pro HD should not be used on Tiger.

. Final Cut Pro HD should not be used with QuickTime 7.

. Soundtrack Pro continues to improve its stability, but it
is not yet ready for heavy professional use.

For current users, these recommendations are relatively easy to follow.
The people that are in a hard position are those folks that just bought a
new computer which comes with OS X 10.4.x pre-installed and have no
way to downgrade to OS 10.3.9. If you are in this position, as a number
of my clients are, don't panic. While the initial release of OS X 10.4 was
fraught with problems, stability and reliability improved dramatically with
the 10.4.2 upgrade. While | don't think 10.4.2 is as solid as 10.3.9,
10.4.2 is by far the best version of OS X 10.4. Most of my clients
running 10.4.2 are running with only a few problems. Still, | don't
recommend 10.4 for any heavy use at this point.

Keep in mind that Final Cut 5 does not take advantage of any of the new
features in OS X Tiger. This means that whether you are running OS X
10.3 or 10.4, the features of FCP are identical.

It also needs to be emphasized to NEVER upgrade in the middle of a
project. Three weeks ago, | upgraded my main editing system (a G-5
2Ghz Dual) from OS 10.3.2 to 10.3.9 and installed Final Cut Pro Studio.
Prior to that I'd been running FCP 5 on a G-4 PowerBook. The upgrade
went fine until it was time to install the data files for Motion, DVD Studio
Pro and Soundtrack Pro. At which point, my second hard drive, where
the files were being stored, completely locked up. The only option was a
complete reformat and start again from scratch. Fortunately, | had
reasonably complete backups, so | only lost a couple days of time in
getting everything recovered. The point of this story is that because |




was between projects | could afford the time to figure out the problem
and get it fixed.

One other note: if you are using non-Apple capture cards, from
companies such as AJA, Blackmagic Design, or someone else, be sure to
check with your vendor about any necessary firmware and/or software
upgrades necessary for the new system. Many, many clients of mine
were stuck by upgrading before all the vendors had their updates ready.
Most updates are finally out and stable -- but a phone call before
upgrading can prevent a LOT of post-upgrade headaches.

More thoughts from Tom Wolsky:

You talk about upgrading your OS and whether or not you should
do that. Apple offers an OS upgrade installation, which | don't
think professional users should use, not even an archive and
install. No professional should "upgrade" their operating system,
ever. You describe upgrading your OS, and the problems that
resulted. Updating, 10.4 to 10.4.2 is one thing, but 10.3 to 10.4 is
a new operating system. For professional applications | believe the
system drive should always be erased and the OS clean installed.
If that's done correctly | have not seen significant issues with
Tiger, perhaps even less than with Panther. There may be issues
related to Spotlight, but that's a user specific problem, and
probably not common to most FCP users.

[Go to top.]

Last Month's Survey:
Are you having problems running Final Cut?

Last month | asked you to complete a survey indicating how successful
you were in running FCP HD or FCP 5 on current versions of the
operating system. While this survey is not scientifically random and can't
be extrapolated to represent the entire FCP user base, | find it helpful in
looking at trends.

This survey came out two weeks prior to the release of OS 10.4.2 and
continued for two weeks after the release.




The first survey asked FCP HD users what operating system they were
using and whether they were having problems. The vast majority of FCP
HD users were running with no problems on OS 10.3.9. However,
respondents running FCP HD in Tiger were evenly split between those
who had no problems and those who did.

The second survey asked FCP 5 users what operating system they were
using and whether they were having problems. While the majority of
users were running on Tiger, a very large percentage were having
problems. While the number of users running on OS 10.3.9 were
smaller, they also reported far fewer problems.

[Go to top.]

New Survey: What tape formats are you editing now?

This month I'm interested in learning whether HD is gaining in popularity




among the projects you are editing. This is a multiple choice survey -
indicate all the different video (or film) formats you are currently editing.
We'll revisit this issue in about six months to see whether things have
changed.

Results are displayed as soon as you vote.

[Go to top.]

Guest Article: Using Final Cut Pro 5

Here's an apropos comment regarding our discussion of using Final Cut
Pro 5. Regular correspondent, Dilesh Korya, wrote:

Thought you may be interested in my experiences editing on
FCP 5.

Firstly, | have been editing an hour long documentary for the
BBC in Bristol. It uses dramatization, interviews, and
specially woven tapestries to illustrate a story dating back to
the medieval period in France. These tapestries were scanned
in at about 400 dpi, converted to JPEGS or TFF's. Then would
change them slightly in Photoshop, etc. In FCP | would use
the motion tabs to create really fancy moves and spins, etc.
You know, the usual things with still pics.

Now | unfortunately | broke your number one rule. |
converted from FCP HD to FCP 5 mid-project. Why? Mainly
because on researching with various people | found out that
FCP 5 has better rendering functions (particularly with JPEG's
and TIFF's) and getting rid of the sticky timeline issue that
has been plaguing my editing since FCP HD.

I can report that converting to FCP 5 was worth the risk. |
found the system was considerably more stable, there were
many complex visual features that | created which would
have crashed the system on FCP HD; for example, creating a
visual transition, with masking parts of the screen, and
gradient wipes, and color glow filters (as well as any other
complex move from the TIFF file). The rendering seemed to
be only slightly better, but not worth thinking about. Most
importantly no sticky timelines anymore!

Even after my experience | would not recommend this unless
your media management is up to scratch.

The main thing to remember for anyone upgrading to FCP 5
is that you MUST have unique names for every single clip in
your capture scratch folder, otherwise you will fail to re-
connect. You will spend hours matching the clips to your




media with no 100% chance of success. Do not convert until
you can see a clear and direct link between any clip and its
media.

I have my own way of naming clips (a hang-over from my
days of editing on Media 100). Each clip when digitizing has
the bin or tape number followed by a slash; then FCP will put
a number by it as each successive clip is brought in. So, for
example, clip 1 from tape 1 (which | would put in bin '001")
would '001/1'; FCP then would increase the last '1' as each
clip is brought in. 001/2, 001/3, etc. This means that each
media has a specific name that relates to the clip in the bin
and consequently is so easy to re-connect when for whatever
reason the media and clip have lost their links. Also | do this
so that my timeline is neat and it does not need superfluous
information like ‘cu of face' etc. Usually you can see this
when you move [the playhead] onto the clip. Also the text
tends to get in the way of sound editing. At end or start of
clips (where most sound work is done). So | like less text on
timeline. Hope you may find this useful.

I will keep you informed of any other things that may be of
interest.

Larry replies: Thanks for this first-hand report. While I really don't
recommend using slashes, asterisks, or colons as part of clip or file
names, as they cause conflicts with the operating system, the rest of
your system sounds good to me. If you need to use symbols, use
hyphens and underscores.

[Go to top.]

Technique: FCP HD and FCP 5
What is Auto-Render and how do you use it?

One of the frequently requested features for Final Cut is the ability to
render in the background. By this | mean that FCP would render effects
in the background while you are editing in the foreground. However, |
have been told by the engineers at Apple that, due to the way FCP is
designed, it is not possible to easily add this feature.

However, in FCP 4, Apple added a new feature called Auto-Render as
part of User Preferences which can go a long way toward solving this
problem -- if you know how to use it.

As | teach my classes I've discovered that many people have not
discovered this function, so | wanted to cover it here today.




About Final Cut Pro

User Preferences... .
System Settings... 4Q

Easy Setup... ~Q
Audio/Video Settings... “3#Q

1. To start, choose Final Cut Pro = User Preferences.

User Preferences

™ Auto Render
start Render after: | 15 minutes
Render: | Open Sequences it)
# Render RT Segments

2. The first screen that comes up is the General tab. Highlighted in the
lower right corner is Auto-Render. The default setting is 45, however, as
you'll learn, | set mine to 15 on my system.

# Auto Render —
Start Render o fter: 15 m@
Render: Open S&querees™ f #--]

™ Render RT Segments

3. Auto-render is, essentially, a timer to tell Final Cut to do something
when FCP isn't busy. This is all well and good, but I'm not going to just
sit there with my arms folded waited for Final Cut to start rendering. So,
I didn't use Auto-render for a long time after it first appeared, until |
discovered something.

You see, the key phrase is "when Final Cut isn't busy." Auto-Render
watches for mouse clicks and key presses. If it doesn't see any incoming
user input (meaning those mouse and keyboard movements) it starts a
clock. In this example, when the clock gets to 15 minutes with nothing
happening, it tells Final Cut to render all open sequences. (The default
setting is to wait for 45 minutes.)

But, here's the neat part. Just because Final Cut isn't busy does NOT



mean your computer isn't busy! Since Auto-render is looking for mouse
click and key presses, all you need to do is move Final Cut to the
background, by starting a different program. A foreground application
receives all mouse clicks and key presses. This means that while I'm
working in PhotoShop, or sending email, or updating my accounting, all
those mouse clicks and key presses are going to the foreground
application -- NOT to Final Cut.

So, the clock starts ticking. After 15 minutes, the clock says to Final Cut:
"well, there's nothing going on here, better start rendering." So, FCP
renders all open sequences, while you're busy working in another
application.

This is very cool -- | keep busy with another part of my production, Final
Cut renders "in the background," and there's no time lost. Rendering in
the background does show down your system, which may be excessive
on slower computers, but I've not found this to be a significant problem.

However, for this system to work most efficiently, change the default
Auto-render setting from 45 (minutes) to 15. That way, Final Cut leaps
into action much sooner.

Open Sequences

Current Seqguence :
Open Sequences Except Current

By the way, you can adjust what FCP renders by selecting from these
three choices. For me, | just leave it set to all open sequences --
including RT sequences.

Very cool.

[Go to top.]

Tip: FCP 5 (and, maybe, FCP HD)
A cool way to duplicate a clip

Well, here's something | didn't know until last week.




Open in Viewer
Oipen in Mew Viewer
Open in Editor

Rewveal in Finder

Batch Capture...

Reconnect Media...

Media Manager...

Make Offlina...

Duplicate as New Master 1
Merge Clips...

Maka Multiclip...

In the past, if | had a Browser clip and wanted to make a copy of it, |
would simply Control+click on it and select Duplicate as New Master
Clip.

But there's a THIRD way. Grab the clip in the Browser, drag it up to the
Name column header, and let go.

Instant duplicate! Son-of-a-gun. | never knew that.

So, now we both do. If you have a tip you'd like to share, please send it
in and I'll publish it.

[Go to top.]




Tips from the Classroom

It wouldn't be a regular issue of this newsletter without a few tips from
the classroom. These are features of Final Cut discovered recently by my
students.

Marlin discovered that if you copy a clip in the Viewer and
paste it into the Timeline, the Patch Panel on the left side of
the Timeline controls which track the clip goes to.

However, if you copy a clip on the Timeline and paste it back
into the Timeline, the Auto-Select buttons determine the
track the clip goes to.

Larry adds: If you are copying and pasting a clip on the Timeline, it will
paste to the same track from which it was copied. However, if you want
to paste it to a different track, change the Auto Select buttons. At which
point, the clip will paste to the lowest humbered track who's Auto-Select
button is dark.

Antonio discovered that typing Cmd++ (the plus key) or
Cmd+- (the minus key) will zoom into, or out of, whatever
window is selected (except the Browser). However, typing
Option++ (plus key) or Option+- (the minus key) will zoom
into, or out of, the Timeline, regardless of whether it is
selected or not.

Larry adds: Furthermore, the benefit to using Cmd++ or Option++ is
that it always zooms by first centering the Timeline on the Playhead. For
this reason, | tend to use Option++ for zooming because | don't have
to worry about first selecting the Timeline or figuring out where the
playhead is.

[Go to top.]

Article: Larry's Tips on Getting a Job in Post-Production
Jake Rake wrote:

| greatly appreciate your posting some of your very helpful
tips online. | am eager to learn as much as | can about Final
Cut Pro, as | am a college student relying on these skills to
earn myself a career in video/film production. What other
resources do you suggest | seek to learn more about video
production and get my name out there?

Larry replies: Sometimes, it seems I've spent my life searching for a
steady job. And, to help my in my search, I've spent a lot of money on
job counseling training and job hunting tips.

In my classes, my students all seem to be between jobs or looking for
something better, so | compiled a list of suggestions based on my
experience that's been useful to me when | am, um, "between projects.”




Here's a baker's dozen:

1. Who you know gets you the interview. What you know
gets you the job. How you do gets you the next job.

2. Enthusiasm and willingness to learn wins over talent.

3. People skills are as important as technical skills

4. A great demo reel is nice. A face-to-face interview is

much, MUCH better.

You are not paid to have opinions on your first job.

There are virtually no full-time jobs in post-production.

Almost all post work is free-lance.

7. Therefore, do every job as though it is the resume for

your next one.

Who you are is as important as your resume.

Who you know is important. Who you GET to know is

critical.

10. Never take “no” for an answer, until you've asked the

question seven times.

11. Always follow-up. Always.

12. Always send thank you notes.

13. Never give up.

oo
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New DVD: Principals of Digital Video

In conjunction with Lynda.com, I've created a new training DVD called:
Principals of Digital Video. This six-hour narrated DVD illustrates many of
the concepts underlying digital video -- fromm NTSC and PAL to screen
resolution and audio sampling. This is designed as a primer on common
video terminology for beginners and intermediate folks alike.

It's currently published on-line at http://www.lynda.com and will be

available for sale as a CD-ROM in about a week. Keep an eye on my
website and I'll let you know when it's available.

[Go to top.]

Technique: Working with Audio Control Surfaces

Godfrey Pye wrote in with a detailed analysis of using audio control
surfaces in Final Cut. | liked his email so much, I'm reprinting here with
his permission.

| believe I've found the answer to the FCP5 control surface
question.

I’'m an FCP editor with no real interest in music creation. Like
a lot of editors | suspect, mine was a Mackie 140Z sound
mixer. It did its job wonderfully, then again its job wasn’t a
very difficult one, it controlled the volume going to the
speakers, recording through the mike etc.

When FCP5 came along | was excited to learn that it was
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possible to buy something I'd never previously heard of, a
‘control surface’ and to mix audio by using physical knobs
and sliders just like a real audio mixing person would. At NAB
however, no one from Apple was able to tell me much more,
like which device | should buy.

So | researched it and found that if | bought a Mackie Control
Surface Universal, I'd have to keep my Mackie mixer as well!
Who needs to have two of ‘em on the desk? | believe Mackie
have missed out big time here.

Then | found the Tascam FW-1082 control surface (I got a
brand new one for $615), which meant | could get rid of my
incumbent Mackie mixer (for $295 on eBay) and mix like a
pro. Actually, | believe that requires a talent that | certainly
don’t claim to have.

The Tascam connects to the computer via Firewire and has
three modes — they are.

Monitor Mix: which replaces the functions my former Mackie
was in charge of, i.e. monitoring audio to and from the
system.

Midi Control: which seems to be something for the music
guys.

Computer Control: It’s in this mode that the magic is
seemingly made. When | finally got it working yesterday —
and here I must send out many thanks to Larry Jordan’s
excellent network, which allowed me to get in touch with the
very kind Tony Liuzzi who talked me through it, after going
through the same initial frustrations as me, but who had
persevered with Tascam until he got it going.

| let out a big Woo Hoo! (Sorry about that Tony) when |
placed a previously mixed project in the timeline and | saw
those faders fly up and down to match the audio mixing
decisions | had made earlier, via all those stop-start-and-
moving-the-mouse-operation that is mixing by FCP, as we
know it. In the Computer Control mode, the Tascam also
allows me to Stop, Start, Rewind, Record, Shuttle a project.
All of this by using the physical mixing board.

I haven’t had time to see if it works with Soundtrack Pro yet.
On paper it does, but that app has enough of its own
problems so I'm staying away from it for now.

| believe Mackie has dropped the ball, at least for the
moment. The Tascam works courtesy of a generic protocol
called the Mackie Protocol, but as mentioned earlier Mackie
does not currently offer a similar price-point board that works
as a solo device to accomplish all that the FW-1082 does.

As for Tascam, | don’t believe they are yet aware of what a
gem they have on their hands as they seemed willing but




confused when | asked them to assist me in getting the
Computer Control settings working with my G5. They didn’t
even have FCP5 in the house at the time.

Once again, thanks to Tony and Larry for helping me work
out the initial bugs — and most of all, for allowing me to look
cool. Now | must practice, practice, practice my audio mixing.

Larry replies: Tony Liuzzi has created a 160K PDF illustrating how to set
up a Tascam audio mixer with Final Cut Pro 5. I've posted it in my
Goodies section. You can download it by clicking here.

[Go to top.]

Reader Mail
Working With Compressor

Last month, Roy Close offered a free copy of his Layman's Guide to
Compressor. This month, Roy wrote:

To date we've had about 250+ requests from all over the
world: your newsletter really is reaching an international
audience. I'm not surprised - all the help | get from your
newsletters!

I'd really like to get some feedback on how people found the
Compressor Report, and any suggestions folks may have to
improve on my "still-learning” effort. Maybe I'll email
everybody and ask for input!

Thanks again for EVERYTHING!
Larry replies: You are most welcome. Thanks for sharing your report

with the rest of us. If you want a copy, contact Roy at
glenroyhbm@pineland.net

Dave Meek wrote:

I recently upgraded to FCP 5 and Tiger. | am presently using
DVCAM and it changed a lot of preferences in how my input /
output through AJA lo LA were handled. But, having figured
that out with the help of AJA support, everything has been
working fine.

Some questions:

. Is it possible to gang edits and add a transition, like a
dissolve, across all the edits at once?

. Is it possible to change several transition durations
simultaneously?

. Under FCP 5 I can no longer find a way to turn the
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"speaker" on (except for preview). Do you know how?
. Can I change the default 1 sec. dissolve rate of a
transition

Larry replies: Dave, most of the answers are not what you want to hear.

No, you can't gang edits and, no, you can't change multiple transition
durations simultaneously. However, you can change the length of the
default transition. Here's how.

1. Go to the Browser and click the Effects tab.

2. Twirl down Video Transitions

3. Find and select the transition you want to change. In this example,
we'll change the length of the default Cross-Dissolve to 20 frames (my
favorite length dissolve).

Cross Dissolve

4. Click in the Length column to select it and type the new value: 20




Make Favorite Effect F
Video Transitions >
Favorites [ ]
Default - Cross Dissolve BT
Set Default

Clear Default ™

Video Filters [ ]

5. With the transition still selected, choose Effects > Video Transitions
> Set Default.

Your default transition has just changed.

You can use this technique to change the transition or it's length. Simply
make whatever changes you want to make, select the transition and
select Set Default.

[Go to top.]

Using Markers
Greta Wing Miller writes:

I am very eager to read your proposed article on markers. |
love them too, and use them all the time. As | watch
interviews (I do docs) | mark notes to myself about cutaways
or connections to statements made by other interviewees.
Because they are so easily deleted, | mark everything that
pops into my head.

Recently, | had another use for markers, and could not figure
out a good workflow. | hope you (or your brilliant students)
can help.

| had to take an interview full length, no editing, and place
still photos at relevant places. A perfect job for markers, |
thought, so | watched it in the viewer, marked it up, and cut
it into the TL after the opening | had created.

The keystrokes for navigating between markers in the viewer
(Shift-m, option-m) don't work on source clip markers in the
TL, and the names of the markers don't show up in the
canvas window when you do get on one...

Larry replies: Greta, it's easier than you think.

Shift+M and Option+M move forward and backward between markers
on the Timeline. But they ignore markers in a clip. Until... you select the
clip. Then, Shift+M and Option+M allow you to jump between markers
in the selected clip, the same as the Timeline.




Uninstalling QuickTime 7
Martin Weiss writes:

Thanks for your down-to-earth advice on which QT/FCP/OSX
combination to use. Unfortunately | am in a bit of a fix, I've
got FCP5, QT7.01 and OSX 10.4.1, which works sort of OK,
but after reading your post, | wanted to downgrade QT to
6.5.2. |1 thus downloaded the re-installer from the Apple-
website, which says that it cannot be run on my machine.
After some research | found out that you cannot remove QT7
from an 10.4.x system. Does this mean that | have to re-
install 10.3? Or is there another workaround for this?

Larry replies: Martin, OS X 10.4 requires QuickTime 7. Don't worry about
uninstalling it. Just get the 10.4.2 update and update Final Cut to
version 5.0.2.

HDV Intermediate Codec
Martin Feldman writes:

We are using FCP HD. How do | get the intermediate codec?
Currently we capture HDV sources (Sony) with iMovie HD and
then import them in FCP.

Larry replies: The intermediate codec ships with Final Cut Pro 5. For FCP
HD, your work-around is probably the best choice.

Tom Wolsky adds:

The Apple Intermediate Codec is, | think, part of QT7. Bolting
the Apple Intermediate codec onto an earlier version of QT
doesn't sound like a good plan, which is one more reason
why | think FCP5 runs best when it's on a properly installed
version of Tiger

Keyboard Shortcuts
Tom Wolsky writes:

Larry, in the last issue, you wrote: "Set an In and an Out in
the Timeline. Press Shift+X to do a Ripple Delete from the In
to the Out.”

This actually does more than a ripple delete. It does a ripple
cut and loads the cut material into the clipboard. It's an
important function with Shift+V for moving groups of clips
around in the timeline.




Larry replies: Thanks for the clarification, Tom. This is a feature | don't
often use and appreciate the update.

[Go to top.]

Don't Forget FCP HD
Jack Mullins writes:

Larry, | enjoy your Final Cut Newsletter. | have learned a lot
and look forward to seeing it every month. We purchased
Final Cut Pro HD the first of the year. | don’t think that we
will be upgrading to Final Cut 5 in the near future. | hope
that you will not forget about us folks out here who do not
have 5 and will not for awhile. It is nice to learn what the
new version will do but | would like to learn more from you
what my version will do also.

Larry replies: Jack, you aren't forgotten. On the other hand, it's nice to
write about something new. In either case, we'll be covering both FCP 5
and FCP HD in future issues.

Capturing to Separate Drives
Jim Schafer writes:

A question. In your excellent article on setting FCP prefs in
your #17 July, 2005 newsletter, you make the statement "3.
Never capture audio and video to separate drives." Are you
sure about this?

My experience with analog capture is that capturing the A &
the V to separated mechanisms is essential to adequate
throughput while capturing. Doesn't the FCP documentation
recommend separate capture mechanisms for A & V?

OK, that being said | will admit that when | first visited this
issue and discovered the need to use separate capture
mechanisms, | was:

a) using FCP 4.1

b) using a far less-expensive and lower quality A/D converter
box than the Canopus ADVC-300 | use now, and

¢) | had a two-drive internal RAID array for video capture
instead of the three-drive internal RAID array | use now.

But | still do a fair amount of analog capture. My capture Mac
is the same dual 1.25 GHz G4 with ATA 100 drives used for
the array (not SATA). | still capture audio to a fast SCSI-2
drive that is connected to the internal Apple (Adaptec) SCSI




card.

Do you recommend that | try to capture audio and video to
the same mechanism for my rig and using FCP HD (and soon
FCP 5 on this box)?

I would appreciate your comments of this issue. Thanks.

Larry replies: Capturing audio and video to separate drives was
necessary when drives were very slow, very small and very expensive. It
is no longer necessary with today's systems.

However, my number one rule is: if it ain't broke, don't fix it. If your
system works for you, please continue using it.

However, for new systems, | do not recommend capturing to separate
drives.

Apple hasn't recommended capturing to separate drives for several
years now. Again, it all revolves around drive performance. If you have
an older system, continue as you are doing. As you upgrade to newer,
faster gear, you no longer need to do so.

Setting Scratch Disks
Gerry Fraibeg writes:

When | set up FCP5 on my Power Mac G5 running Tiger, |
followed your Hands On Training book and created a folder
called FCP Media on my second drive.

Then after trashing Preferences when | experienced some
system lock ups during Log and Capture, | followed the
tutorial on your latest newsletter - Setting FCP 5 Preferences
- which recommends naming the folder Final Cut Documents.

Or at least | thought I was following it. | wound up putting
the Final Cut Documents folder in the FCP Media folder
instead of renaming it. Everything appears to be working,
and the project | am working on loads fine.

The question now is do | have to trash preferences and start
over, or will the system continue to work with the FCP
Documents folder within the FCP media folder?

Larry replies: None of the above.

Ever since | wrote the first edition of my FCP book, I've been debating
with myself the best way to name the Scratch Disk folder (yes, | know,
it's pretty trivial, but for some reason | have obsessed about this). After
watching how FCP works and talking with Apple, | realized a better way
is to name the folder Final Cut Pro Documents.

So, the next version of the book and my website have changed to reflect




this.

Ideally, the Final Cut Pro Documents folder should replace the FCP Media
folder, not be contained in it. The benefit to this is that when you trash
preferences, FCP will look first for the Final Cut Pro Documents folder on
your scratch disk, thus improving reliability.

The easiest thing to do is rename the FCP Media folder to Final Cut Pro
Documents, move all the files from the old Final Cut Pro Documents
folder into the new one, then delete the old folder. You'll need to relink
your files, but this is a one-time only thing.

Sorry for the change in philosophy, but I've found this system works
better.

[Go to top.]

File Maintenance
Patric Anderson writes:

Larry, thanks for the info on Live Type...... Has anyone ever
asked you or have you addressed a problem with Final Cut
Pro (HD) or other versions where several projects (some very
large with lots of graphics) are updated weekly?

This is in a TV station where episodic spots are updated with
new clips...... the sequences in the projects remain the
same....only the clips change...... I've had these projects for
well over a year and another editor suggests erasing all my
media and deleting all the projects and starting from scratch
because he thinks that it's not good to just keep updating the
sequences over and over........ with all that said, SHOULD | do
as he suggests or do you know of, hopefully, a less labor
intensive way to keep FCP running well and/or not crashing ?

Larry replies: The best thing to do is periodically do a Save As... on your
main project file and give it a new name. That will straighten out any
potential problems before they get serious. It's much easier than
trashing everything and starting over.

JVC GY-HD100U camera

There was some dialog recently on the Apple Trainer's forum about
whether Final Cut supports the JVC GY-HD100U camera shooting HDV in
720p 24 frame mode. The word from Apple engineers is that FCP does
not support this video format.

The HDV supported formats are: 1080i60, 1080i50 and 720p30.

[Go to top.]




Backups and Archives
lan Barmer writes:

I have a query which I thought might make an item for one

of your newsletters. | want to make back-ups of FCP project
files, so that if my hard disc were to fail, | could still go back
to any project I've edited.

My question is this: If | copy the project file onto CD from my
FCP Projects folder, will that include ALL of the project
information? And if | then wanted to put that project file onto
another computer, what would be the best way to do it?

I have never seen an article which covers this - unless of
course | simply haven't looked hard enough....

Larry replies: The short answer is yes. FCP project files contain
everything EXCEPT media. So, if you need to restore a project from a
backup CD, simply copy it from the CD to your hard drive. If your media
has been lost, you'll need to recapture it using Batch Capture.

I've written an article that describes the process. You can read it by
clicking here.

Problems capturing
Mike Jimenez writes:

First, my stats. | have FC 5.0.2 on a dual 2ghz G5 with 2.5
Gigs of Ram, running OS 10.4.2.

A client | had wanted me to do some DVDs, and | figured it
was time to buy DVDSP. | went all out and bought the Studio
upgrade. After installing the software | opened and worked
on a very short project for a client, just to see how FC5
worked out. Seemed fine. Then | upgraded to QT 7.1 and it
KILLED FC. Within a day | wasn't even able to open the
program.

Luckily I have everything on LaCies, so | knew | could still
get at my projects if | could run FC. | asked a few editor
friends and in the end did a clean install. A big pain, but
there didn't seem to be another solution. After the clean
install everything seemed to be working fine. Another editor
friend kept telling me he was having problems with the sound
slowly going out of sync upon capture. | didn't have any
problems, even after doing a big project, so | thought | would
be ok. Started a new project and half of the captured content
(using a Sony DSR-11) slowly went out of sync, while the
other half was fine.
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We've asked around and it seems almost everyone we know
using FC 5 has the same sound sync problem. Some are
using decks to import, some using cameras. What are we all
doing wrong? And if we're not doing anything wrong, how
could Apple release software with such a HUGE deficiency? If
this is a bug, doesn't that mean that almost everyone using
FC will have a problem with almost every project they try to
work on?

I don't know, just miffed and need to blow off some steam. If
you or your readers have any answers, I'll be sure to pass
them along the the editors | know.

Larry replies: Mike, there are known issues of sync drift in certain
circumstances when using Capture Now. Be sure to set an In and Out on
your tape and capture it using Capture Clip.

Be sure, also, that you are capturing your audio at the same sample rate
it was recorded. If you shoot 32K audio, sometimes called 12-bit, you
need to capture at 32K. | had this problem once, and it nearly killed me.
Normal DV audio is shot and edited at 48K (16-bit).

However, Tom Wolsky disagrees with me on this point:

This is more bad-mouthing of capture now. There is no sync
drift caused by capture now. There are no issues, other than
possible FireWire protocol issues with Canon cameras, related
to capture now. Capture now is exactly the same function as
capturing with 1/0. You'll get exactly the same results. If
your tape or settings are screwed up one way, they'll be
screwed up the other way as well.

Just to add, [this seems to me to be] another user with
problems because he didn't do a clean install.

Larry adds: If anyone else has any suggestions, I'd like to hear them.

Disappearing Canvas and Timeline
Rick Forester writes:

I've run into a problem with trying to re-activate the four
primary views in FCP. When | try to open the timeline and
the canvas windows using CMD+2 and CMD+3, nothing
happens. When 1 try to open them by pulling down the menu
option, the timeline and canvas are grayed out.

Is this another case of preferences going south? If not, how
do | go about correcting this situation?

Your assistance is much appreciated.

Larry replies: Open a sequence and the Canvas and Timeline will
reappear. If no sequences are open, the Timeline and Canvas are not




available.

Send in your comments and questions -- sharing your ideas, questions
and discoveries helps us all to learn.

Wrap-up
Thanks for reading this issue of the newsletter.

Please remember to tell your friends about our Chicago seminar. And I'll
let you know as soon as my new book is off the press.

As always, let me know what you think about this issue and tell your
friends to subscribe. | love reading your comments and sharing them
with others.

Or, send in some ideas of what you'd like us to talk about.

Even better, send in some tips of your own. I'm happy to publish
everyone's ideas. That way, we all learn!

Thanks -- and edit well!
Larry

[Go to top.]
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your
friends to sign up at www.larryjordan.biz.

To unsubscribe, simply send me an email and I'll drop you from the list. This
list is not sold, rented, or bartered. The only person who knows you are on this
list is me.

The information in this newsletter is believed to be accurate at the time of
publication. However, due to the variety of possible system and software
configurations, the author assumes no liability in case things go wrong. Please
use your best judgment in applying these ideas.
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The opinions expressed in this newsletter are solely those of the author. This
newsletter has not been reviewed or sanctioned by Apple or any other third
party. All trademarks are the property of their respective owners and are
mentioned here for editorial purposes only.

Text copyright 2005 by Larry Jordan. All rights reserved. This newsletter may
not be reproduced or published in any way, in whole or in part, without specific
written permission from the author.

Links to my website home page, or articles, are welcome and don't require
prior permission.

Updated: September 23, 2005 H Go to Top of Page || Go To Larry's Home Page || Send eMail to Larry



http://www.larryjordan.biz/index.html
mailto:larry@larryjordan.biz

	Local Disk
	Larry's Final Cut Newsletter #18


	AMJMLKODCAIFPJBPCIDKNLAJNNNIPBMK: 
	form1: 
	x: 
	f1: 
	f2: 1011294719044
	f3: oi

	f4: Go
	f5: 




